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1 Introduction

The Sidescan®Predict system is designed to give warnings to the driver of dangerous
scenarios involving objects in the blind spot, while ignoring objects that are not at risk from
the vehicle. The system has a range of 2.5 metres from the side of the vehicle and covers
the most dangerous area with no gaps. The system is active whether the indicator is on or
off and shuts off above 30 km/h. The system uses a combination of ultrasound sensors,
vehicle indicator/reverse triggers and vehicle motion monitoring to determine the level of
danger before alerting the driver.

The installation process for the Sidescan®Predict should be followed carefully to ensure
that the resulting system installation operates correctly. An incorrect installation will reduce
the effectiveness of the system in preventing collisions and cause increased false alarms.
Compliance with any standard is not guaranteed and will depend on the sensor
configuration used.

Sidescan®Predict is designed to work on rigid vehicles with a length of 5.2 metres or greater.
Vehicles must be fitted with a tachograph that uses a transmission speed sensor and
provides a B7 output for the system to operate correctly.

The system is intended as an aid only. The operator must still concentrate on operating the
vehicle, obeying traffic and local regulations and continuing to use their own training, senses,
and other vehicle aids, such as mirrors, as if the system were not in place. Nothing removes
the responsibility of the operator to operate the vehicle in a proper and lawful manner.

1.1 Alarm Outputs

The alarm output on the Sidescan®Predict buzzer display is designed to alert the driver to
danger on the installed side and notify the driver of any system malfunction. The buzzer
display has visual and audio indicators as shown:

I
\ Volume
/ || ¢—1— Control
Visual Alarm > V Buttons
- )
Power/Fault LED
Speaker
(Audio Alarm)

4 Sidescan®Predict buzzer display

1.1.1 Alarm Outputs During Vehicle Operation

The system uses graduated alarm levels depending on the level of danger. Moving objects
will activate a visual alarm but audio alarms will only be activated when the system detects
a dangerous situation. The purpose is to minimise driver habituation and irritation while
ensuring audio alarms are still given in dangerous scenarios. The different alarm levels are
described below.

* No alarm: There will be no visual alarm when there is no danger detected on the
installed side of the vehicle. The power/fault LED will be illuminated green to
indicate that the system is running.

* Moving object alarm (no audio): When a moving object is detected on the installed
side the visual alarm will show a solid yellow warning.

* Close moving object alarm (no audio): When a moving object is detected close to
the vehicle whilst the vehicle is moving, the visual alarm will show a flashing yellow
warning.

* Danger of collision alarm: When there is a danger of collision, a beeping audio
alarm will be emitted and the visual alarm will flash yellow. “Danger of collision” is
defined as situations where:

o An object moves from the back to the front of the vehicle whilst the
vehicle is moving and either indicating or turning to the installed side.

o An object is detected within 0.5 metres of a sensor whilst the vehicle is
turning.

o A collision is predicted within 1.5 - 2.5 seconds.

o The vehicle is reversing in a turn and a collision is predicted within 1.5
seconds.

* Collision predicted alarm: When a collision is predicted within 1.5 seconds and the
vehicle is not reversing, a high-pitched beeping audio alarm will be emitted and the
visual alarm will flash red.

* System off: When the vehicle is running at a speed above 30 kph/18.6 mph the
system will shut down and no visual or audio output is given.

There are two additional states when the vehicle is stationary in which the system will give
specific warnings.

* Stationary awareness alarm (no audio): If there are any objects, stationary or
moving, within 1 metre of a sensor within the front 6 metres while the vehicle is
stationary and indicating to the installed side, the visual alarm will show a solid
yellow warning.

* Stationary warning alarm: If an object moves up the installed side within 1 metre
of the vehicle whilst the vehicle is stationary and indicating to the installed side, the
system will emit a single “beep” and the visual alarm will show as solid yellow.
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1.1.2 Alarm Outputs for Installation and Maintenance

There are also several alarm states to show the status of the system during start-up, fault,
or configuration.

* At system start-up the buzzer display will perform the following start-up sequence:
Red visual warning -> Yellow visual warning -> On (green LED). Each visual
warning is accompanied by a beep. This confirms the visual and audio functions of
the buzzer display are working correctly.

* If the system is not configured, the power/fault LED will illuminate red.

* When the system self-diagnoses a fault with a sensor or vehicle data input, the
power/fault LED will illuminate amber.

* When the buzzer display is powered but receiving no data, the power/fault LED will
flash alternately green and amber.

* When the system is connected to the configuration software there will be a flashing
green light on the power/fault LED.

See the troubleshooting guide in Section 7.3 for dealing with these faults.

System Power/fault | Visual Audio Image

state LED alarm alarm

System None -> Red -> Beep ->

start-up None -> Green -> Beep -> A A
(buzzer Green None None e -
display

self-test) > >
System not | Solid red No light None

configured | light

System Solid amber | No light None

fault light

System Vehicle Power/ fault | Visual alarm | Audio alarm | Image
state state LED
No alarm Any Green light No light None
Moving Any No light Yellow light | None
object
alarm
Close Driving No light Flashing None
moving yellow light
object (2 Hz)
alarm
Danger of Driving and | No light Flashing 2 beeps/sec
collision EITHER yellow light

turning or (2 Hz)

indicating
Collision Driving and | No light Flashing red | 8 beeps/sec
predicted turning light (8 Hz)
System off | Driving No light No light None

faster than

30 km/h
Stationary | Stationary No light Yellow light | None
awareness | and
alarm indicating
Stationary | Stationary No light Yellow light | Single beep
warning and
alarm indicating
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System state | Power/fault | Visual Audio Image 1.3  Detection Pattern
LED alarm alarm This section shows the detection pattern measured with a 110 mm pole as the target. The
actual detection pattern will vary depending on the target used.
No firmware/ | Alternate No light None >
no buzzer green and 1.3.1 Horizontal Detection Pattern
message amber light
< T 20 s : 10° ; 10 20° o ‘ ‘250
T AT N ‘
“ yZd __\L e
Connected to | Flashing No light None N v NC i
configuration | green light 200
software N
< . =l
150
i - B ; : . [T
1.2 Detection Range and Capability " \ . ; | i
Sidescan®Predict takes measurements from all sensors 10 times per second and will detect N | ‘ ‘ Il
objects that appear in the detection area up to 2.5 metres from the installed side of the . \\ —t I A 7 -
vehicle. ERAN T ' : // -
There are some situations in which objects may not be detected. These are described below. w0 - ™ // )
,‘ —— 30
* Size and shape: The system reliably detects pedestrians, cyclists, motorcyclists and N ‘_s’/ i "
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sufficient reflection from the ultrasound pulse to be detected consistently. SSP-00HSS-B (black sensor) horizontal detection pattern (cm)

* Material and surface: Ultrasonic pulses are sufficiently reflected from humans,
vehicles, and roadside furniture. However, sound-absorbent materials or surface

10° 100 20° 30°

finish (e.g. cardboard) will reflect less energy and may not be detected at the full range. ) ‘F o T ZP), T
o | ‘ | X X\ 1400230
* Distance: Objects which fall outside of the sensor detection pattern will not be [ / | L N 220
detected. The height of objects detected will depend on the mounting height and ' 1 e
angle of the sensors. Detection patterns are given in Section 1.3. ! ——e0
* Temperature: The operating temperature for Sidescan®Predict is -30 to +70 °C. w0 _ | i
There are also situations in which background noise can cause false detections on the i / o
sensors. This is typically caused by vehicle pneumatics, jet washing and street sweepers. \ [/ _ ﬂjjﬁ
In most cases this noise is filtered out and will not cause a visible or audible alarm to . “ ,' iﬁi
the driver. \ / 0
\ / ;
o T ! / 70" 70
_ B , ,/ .
| N\, - ’ A 50
80° [ ‘\ : N / 807 0
| N~ A R ! 20
| - N NAT ] o
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SSP-00HSS-W (white sensor) horizontal detection pattern (cm).
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1.3.2 Vertical Detection Pattern
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SSP-00HSS-B (black sensor) vertical detection pattern (cm).

250
240
230
220

210

90

180

170

160
150

140
130

120

110

™~

100

20

10

200 190 180 170 160 150 140 130 120 110 100 90 80 70 60 50 40 30 20 10 0 10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200

SSP-00HSS-W (white sensor) vertical detection pattern (cm).

1.4 Classification as Moving or Stationary

The classification of moving and stationary objects alongside the vehicle is dependent on
relative movement between the vehicle and object. Classification as stationary or moving
will affect the alarm state as described in Section 1.1.

To ensure visual and/or audio alarms to the driver are useful, the system will not classify as
moving objects pedestrians or other vulnerable road users when they are being overtaken

at a significantly greater speed. If the speed differential changes (by the vehicle slowing, or
the vulnerable road user speeding up) the object will be reclassified as moving. Alarms for

predicted collisions will still be given in either case.

1.5 Reduced Functionality Mode

If a fault is detected but sufficient elements of the system are still operational,
Sidescan®Predict will revert to the behaviour of an indicator-activated, non-predictive
Sidescan system with 1.0 metre range. Audio alarms will be emitted for any object within
1.0 metre of any working sensor. Reduced functionality mode will remain active until the
error/s is/are resolved, offering some functionality to prevent collisions. The error/s must be
resolved to return the system to full functionality.

There are several possible causes for this as discussed in “Testing and Maintenance”
(Section 7) but if this is due to a faulty or disconnected sensor/s this will be indicated by
beeps at start-up. The number of beeps indicate the number of faulty or disconnected
sensors.

The power/fault LED will illuminate amber to indicate an error state. The output triggers
3 and 4 will be activated and output trigger 2 will be deactivated at all times. The output
trigger 1 will continue activating as normal based on indicator signals.

When reduced functionality mode is active, the vehicle’s installed side indicator is on and
speed is below 30 kph/18.6 mph a constant audio warning will be emitted and a solid yellow
visual warning displayed for any object detected within 0.6 metres of a working sensor. A
4 bps audio warning will be emitted and 4 fps flashing yellow visual warning displayed for
any object within 0.6 to 1.0 metres of a working sensor. This will happen irrespective of the
number of sensors that are broken.

1.6 System Fault Mode

If a fault is detected with the system, where there is insufficient confidence to activate
reduced functionality mode, the system fault mode is activated. There are several possible
causes for this as discussed in “Testing and Maintenance” (Section 7).

The power/fault LED will illuminate amber to indicate an error state and no alarms will be
given. The output triggers 2, 3 and 4 will be activated at all times. The output trigger 1 will
continue activating as normal based on indicator signals.

11



2 Contents

2.2

Full List of Contents (In 6 Sensor Kit)

This section covers the components of the Sidescan®Predict system.

2.1 Main System Components

Part

Image

Mounting location

Sidescan®Predict
Buzzer Display

« IP30.

* Mounted inside the
vehicle cab only.

» Must be clearly visible for
the driver, but not interfere
with the driver’s view.

* Mounted in a location that
reflects that the system is for
side detection only.

Sidescan®Predict
Algorithm ECU

« IP30.

* Must be mounted onto a flat
surface inside the vehicle
cab only.

* Must be mounted in correct
orientation.

* Ensure there is access to the
USB connector.

Sidescan®Predict
UDS ECU

* IP69K.
+ Can be mounted in the
vehicle cab or on the body.

Sidescan®Predict
Ultrasonic Sensor

« IP69K.

* Mounted on the side of the
vehicle to monitor the blind
spot.

» Use configuration software
and pre-installation survey to
find suitable locations

12

1x UDS-00SS UDS: F (0°) SENSOR SLEEVE
1x UDS-05SS UDS: FO (57) SENSOR SLEEVE
1x UDS-11SS UDS: F1(11°) SENSOR SLEEVE

(e

SSP-1000-AI-ECU
Sidescan®Predict Algorithm ECU

SSP-1000-ECU
Sidescan®Predict UDS ECU

[ — 1

SSP-00HSS-B.
SIDESCAN®PREDICT SENSOR (BLACK)

E

SSP-00SM-KT
‘SIDESCANGPREDICT SENSOR MOUNT ASSEMBLY KIT

1x UDS-18SS UDS: F2 (187) SENSOR SLEEVE

- sEe———

ilEImGE 58

SSP-HSSB-KT (x 2)
Sidescan®Predict Sensor Kit (Black)

INIE

SSP-0.3-AC1

Sidescan®Predict Adapter Cable -

3 to 4 pins - 30cm

SSP-10-SC

Sidescan®Predict Extension Cable - 10m

M= T

SSP-1000-DPW
Sidescan®Predict Buzzer Display

=

SSP-00HSSW
‘SIDESCAN®PREDICT SENSOR (WHITE)

1 UDS-055S UDS: FO (57) SENSOR SLEEVE MKT
1XUDS-118S UDS:F1 (117) SENSORSLEEVE  SIDESCAN®PREDICT SENSOR MOUNT ASSEMBLY KIT
1x UDS-18SS UDS: F2 (18°) SENSOR SLEEVE
1% UDS-2685 UDS: F3 (26°) SENSOR SLEEVE

SSP-HSSW-KT (x 4)
Sidescan®Predict Sensor Kit (White)

SSP-0.4-SP (x 2)
Sidescan®Predict Splitter Cable - 40cm

MHEC T E——— (] &=

SSP-0.3-AC2
Sidescan®Predict Adapter Cable -
UDS ECU to ALGO ECU - 30cm

UDS-2.5BC (x 8)
3-Pin UDS Extension Cable 2.5m

I TH
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2.3 Optional ltems and Configurator (Not Included in 6 Sensor Kit)

Sidescan®Predict

:z@} !/ u X ?9;?“

IEImE=

F =[]

UDS-4.5BC (x 7)

3-Pin UDS Extension Cable 4.5m

| —

Rt2 K12 K12 ! K172 K12 R12

52 R A

0-30kph/0-18.6mph > 2.5m/8.2ft

www bigade-electronics.com

SSP-6000W-DI-QG
Sidescan®Predict SSP-6000W
Driver Information Sheet

o
A A
g

==

NP N
ﬂﬁﬁ <«:g:\m ﬂé D;
'ﬂ i il
LRl il ﬁ"

SSP-1000SCT Sidescan®
Predict Sensor Configuration Tool

GENERIC-UG-SW-QG

Sidescan®Predict Configuration Software Link

Card

i|

[
THIS WAY UP
ECU CALIBRATED
L DO NOT MOVE
P T TR

SSP-1000-Al-ECU-CAL-LBL
Calibration Warning Label for
SSP-1000-Al-ECU

2.3.1 Extension Cables

UDS-15BC: 3-Pin UDS Extension Cable - 15m
UDS-30BC: 3-Pin UDS Extension Cable - 30m

MW=L B ; e

SSP-2.5-SC: Sidescan®Predict Extension Cable - 2.5m
SSP-4.5-SC: Sidescan®Predict Extension Cable - 4.5m
SSP-15-SC: Sidescan®Predict Extension Cable - 15m
SSP-30-SC: Sidescan®Predict Extension Cable - 30m

2.3.2 SSP-1000-CT-01: Sidescan®Predict Configurator Kit

O3 .
mﬂ“ Bé@g@ = [
SSP-1000SCT USBA-CBL-2
Sidescan®Predict Sensor Configuration Tool USB Extension Cable - Type A - 2m
| B
SSP-1000SCT Sidescan® DDEEME{E% 5 = =

Predict Sensor Configuration Tool

[

SSP-01PIC
Sidescan®Predict Sensor Programmer
Power Cable

2.3.3 28 mm Diameter Hole Cutter

SSP-1000SCT-QS

Sidescan®Predict Configuration
Software Link Card

@28mm

UDS sensor hole cutter
Part number 3732

15



3 Before Installing

3.1 Important Notes

B7 CONNECTION
PLEASE ENSURE THE SPEED PULSE INPUT WIRE IS CONNECTED
TO THE B7 OUTPUT OF THE TACHOGRAPH (NOT B8)

PRE-INSTALLATION SURVEY
A PRE-INSTALLATION SURVEY IS STRONGLY RECOMMENDED TO ENSURE THE
VEHICLE IS SUITABLE FOR FITMENT OF THE SIDESCAN®PREDICT SYSTEM AND
TO DETERMINE THE MOST APPROPRIATE SENSOR MOUNTING LOCATIONS

SENSOR MOUNTING
PLEASE DO NOT DRILL ANY HOLES TO MOUNT THE SENSORS UNTIL THE
POSITIONS HAVE BEEN VERIFIED BY THE CONFIGURATION SOFTWARE

3.2 Example Installations

This example installation shows the Sidescan®Predict sensor configuration on a tipper
vehicle.

SSP-00HSS-B (black sensor) horizontal detection pattern (cm).

16

This installation has the dimensions given in the table below.

Vehicle length (m) 9.0
Vehicle width (m) 2.36
Installation side Left
Number of sensors 6

Sensor horizontal distance from front of | 0.36, 1.95, 3.42, 5.11, 6.55, 7.93
vehicle (m)

Sensor height above ground (m)

0.96, 1.13,1.17, 0.99,1.19, 1.2

This is provided as an example only and the best sensor locations will vary from vehicle
to vehicle. Sensor configuration will affect the performance of the system. Please read the
following important guidance regarding best sensor locations.

3.3 Sensor Positioning for Best System Performance

It is crucial to minimise the variation in sensor heights. This is the difference in height
between the highest sensor and the lowest sensor. The less variation in sensor height, the
fewer false alarms will be generated by the system. The maximum variation is 0.4 m, but
the ideal installation has all sensors at the same heights.

Ideal installation. All sensors at the same heights.

Where it is not possible to install sensors at the same height performance degradation can
be mitigated by positioning sensors 1, 2 and 4 lower in the array. This configuration may be
used for installations where sensors 3, 5 and/or 6 must be mounted in or on a high wheel arch.

Acceptable installation. Height variation between sensors
but sensors 1, 2 and 4 are low in the array. 17




3 Before Installing

A configuration where sensors 1, 2 or 4 are higher in the sensor array is valid but will not
perform as well and false alarms will be higher.

Ideal installation. Avoid having sensors 1, 2 or 4 high in the array.

A configuration where the variation in sensor heights is greater than 0.4 metres is not valid.

If this condition cannot be met the system should not be fitted to the vehicle.

Gap larger
than

Acceptable installation. Height variation between lowest and highest sensor is greater than 0.4 m.

Note that any changes to the height of parts of the vehicle will also affect operation. Fit
the system with the vehicle body at the normal ride height. If the ride height varies during
operation fit the system in the worst-case scenario so that any height variation does not
invalidate the sensor configuration.

IMPORTANT: The configuration software will permit sensors to be fitted with a
horizontal spacing of up to 2 metres, but the horizontal spacing should be kept at a
maximum of 1.7 metres where possible.

IMPORTANT: Sensors should be mounted flush with the side of the vehicle where
possible to minimise the chance of vehicle self-detections.

IMPORTANT: Sensors should not be fitted horizontally adjacent to a steering axle
where the wheel might be detected. Mounting higher than the top of the wheel at a
steering axle will not usually cause a problem.

IMPORTANT: Use the software to confirm sensor positions before doing any physical
installation. Pre-installation survey is strongly recommended to ensure the system
can be fitted.

18

4 Configuration Software

This section covers the Sidescan®Predict configuration software.

4.1 PC System Requirements

The configuration software is designed to work with a Windows 10 PC or laptop. Operation
with older versions cannot be guaranteed. The PC or laptop must have a USB port to
connect to the algorithm ECU. Administrator rights are required to use the software.

Minimum screen resolution is at least 1280 pixels in the horizontal and 960 in the vertical.
A list of some compatible screen resolutions is given below:

1920 x 1080, 1680 x 1050, 1400 x 1050, 1280 x 1024, 1280 x 960

IMPORTANT: The Windows “Scale and Layout” setting should be set to 100%
magnification. Some features may not be usable at higher magnifications. These
settings are accessible from the Windows Display Settings page.

A warning will be given if operating below the optimum resolution or screen magnification.
Pressing OK will exit the program and show the Windows Display Settings screen to adjust
the settings. Pressing Cancel will continue at the lower resolution.

Display size too small x

g The vertical resolution is only 200 pixels. We recommmend at
least 960 pixels. Try increasing the resolution or reducing the
magnification in Windows Display 5ettings.

Press OK to change the settings [you will need to run the app
again) or press Cancel to continue with this resolution.

OK Cancel

Screen resolution warning.

4.2 Getting the Software

The configuration software is available for download from the Brigade website,
https://brigade-electronics.com/.

It can be found by clicking Product Support >> Software >> Sidescan®Predict.

19



4 Configuration Software

4.3 Configuration Tool Software Installation

Download the installer file from our
website. Run the downloaded installer
file on the device that will be used for
the installation. The setup wizard will
appear. Select “Next”.

Agree to the license agreement and
click “Next”.

Select the installation folder and click
“Next”.

20

#8 Configuration Software - X
Welcome to the Configuration Software Setup [l
‘Wizard =2 |

The installer will quide you thiough the steps required ta install Configuration Softwars on your
computer.

WARMING: This computer program is pratected by copyright law and intemational treaties.
Unauthorized duplication or distribution of this program. o any portion of it, may result in severe civil
of criminal penalties, and will be prosecuted to the maxinum extent possible under the law.

< Back Cancel

88 Configuration Software - x

License Agreement =l

Please take a moment to iead the license agreement now. IF you accept the terms below, dlick "
Agree'”, then "Next". Otherwise click "Cancel”

MICROSOFT SOFTWARE LICENSE TERMS

MICROSOFT SYSTEM CLR TYPES FOR MICROSOFT SQL SERVER 2014

These license terms are an agreement between Microsoft Corporation (or
based on where you live, one of its affiliates) and you. Please read them.

They apply to the software named above, which includes the media on
which you received it, if any. The terms also apply to any Microsoft

O Do Mot Agres @ | Ages

Nest > Cancel

ﬁi:" guration Software — *
Select Installation Folder =l

The installer will install Configuration Software to the following folder.

Toinstall in this folder, click "Mext". To install to a different folder, enter it below or click "Browss"!

Falder:
C:\Program Files (x86)\Brigade Electronics\Configuration Software’, Erowse

Disk Cost.

Install Canfiguration Software for yourse, orfor anyons who uses this computer

(® Everpone
O Just me

<Back Cancel

Confirm installation then click “Next”. 1§ Configuration Software - X
Confirm Installation

The installer is ready ta install Configuration Software on your computer.

Click "Next" to start the installation

< Back Coancel

Installation complete - click “Close”. % Configustion

Installation Complete

Configuation Software has besn successfully installed

Click "Close" to exit.

< Back Cancel

A shortcut will appear on the desktop.

(o

210 =5
Lredicrm

4.4 Using the Configuration Tool Software
4.4.1 Installation File, Vehicle Configuration File and Sensor Configuration File

The Sidescan®Predict configuration software uses an individual installation file (.bif) for each
installation. This is linked to the unique serial number of the algorithm ECU. A different installation
file must be used for each installation. This file will save automatically as the installation progresses.

When you open the software the first window will provide the options to create new or use existing
installation. To create a new installation file, click “New Installation”.
To return to an existing installation, click “Open an Existing Installation”. 21



4 Configuration Software

Sidescan @ Predict x

BRIGADE|

New Installation
Open Existing Installation

First window that appears allows selection of an existing or new installation.

To save and reuse vehicle configuration files (.bvc) or sensor configuration files (.bsc) on
other vehicles, where the installation is identical, use the “File -> Open” and “File ->
Save as” menu items when the vehicle details or sensor details input forms are open.
4.4.2 User Interface Overview

The components of the user interface are defined in the image below.

Main menu

[BRIGADE] : e l ‘ Progre#s bar ‘ g

System visualisation window

Input form/
output area

- v 7

Dt Ci G o el (s st

[ 1~ ECU connection-area | -

Components of the configuration software user interface.

4.4.2.1 Main Menu

File: “Open”, “Save as” and “Reset form” are used for vehicle details and sensor details
input forms. “Last configuration” will load the most recent configuration. “Exit” will close
the program.

Edit: “Edit data” will unlock a locked vehicle details or sensor details input form.
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Comms: Use this menu to get the configuration, fitting log or error log from a connected
algorithm ECU. Firmware update is also accessible from this menu (see 4.4.3). The
algorithm ECU must be connected to the configuration software to use these functions.

ELM: “Run ELM” will activate ELM (Environmental Learning Mode) on any connected
sensors. “Check ELM” will check the current state of ELM on any connected sensors. The
algorithm ECU must be connected to the configuration software to use these functions.

Help: “Diagnostic mode” can be accessed to monitor and record the current output of the
system. “Get ECU details” will display the firmware version, boot count and serial number

of the algorithm ECU. The algorithm ECU must be connected to the configuration software
to use these functions. “About” will display the configuration software version.

4.4.2.2 Progress bar

Follow the forms and tests in this bar from left to right to complete a vehicle installation.

4.4.2.3 Input form/output area

Used for input of vehicle details and sensor details. Used for output display during system
tests.

4.4.2.4 System visualisation window

Displays a graphical representation of the current setup showing length of the vehicle,
wheel positions and sizes, and sensor positions.

4.4.2.5 ECU connection area

Interface to connect to/disconnect from the algorithm ECU and COM port selection controls.

4.4.3 Firmware Update

When the configuration software connects to the algorithm ECU it will check the current
firmware version. The configuration software available on the Brigade website will have the
most up-to-date firmware bundled.

If there is no valid firmware on the algorithm ECU the configuration software will show a
“Firmware Needs Updating” dialog box to inform the user that the firmware needs to be
updated:

Firmware Update Required *

:l The algorithm ECU requires a firmware update.

OK I Cancel
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4 Configuration Software

If there is valid firmware on the algorithm ECU but the configuration software has a later
version the firmware update menu item (Comms->Send Firmware) will become active and
the following dialog box will be shown:

Firmware Update Available x

'ﬁ A firmware update is available for the algorithm ECU,
L

= Current ECU firmware: Version 0.39
Available ECU firmware: Version 0.43

To download, go to the "Comms” drop-down menu.

To upload the firmware to the algorithm ECU, select Comms->Send Firmware from the
drop-down menu. The same “Firmware Needs Updating” dialog box will then be shown:

Firmware Update Required *

:l The algorithm ECU requires a firmware update,

OK I Cancel |

From this dialog box click "OK” to begin the firmware upload. A progress counter will run
from 0 to 100%. After several seconds the algorithm ECU will restart and the configuration
software will reconnect. Either of the below messages means the configuration software
has reconnected to the algorithm ECU. The current firmware version can be checked by
clicking Help->Get ECU Details from the dropdown menu.

Connected: New ECU X Connectec: Same ECU x

dn Connected to a new ECU. ECU serial number will be recorded i‘l-_-.\'\ ECU serial number matches installation file, Loading all
¥ tofile. W' previously performed tests.
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5 System Configuration Tutorial

This section goes step by step through the software installation process. Follow the
buttons in the progress bar from left to right, starting at “Vehicle Details”, and finishing at

“Export to ECU”.

Progress bar at the start of an installation.

The overall process is as follows:

1. Input the vehicle and sensor details using the input forms to confirm valid sensor
positions. This can be performed without any Sidescan®Predict hardware.

. Install the hardware to the vehicle and connect to the algorithm ECU.

. Run the tests to ensure the system is installed correctly and activate ELM.

Export the configuration to the algorithm ECU.

Save the configuration files from the algorithm ECU to verify the installation.

. Disconnect from the system.

. Restart the system.

NoOOh W

5.1 Vehicle Details Input Form

Click the Vehicle Details button at the far left of the progress bar. This will open the vehicle
details input form. This step involves inputting the details about the vehicle into the
configuration software. The required measurements are as follows:

1. Measure the vehicle length from the front to the back of the vehicle. The length
must be between 5.20 and 20.0 metres.

2. Measure the width of the vehicle at the cab (excluding wing mirrors). The width
must be between 2.00 and 5.00 metres.

3. Measure the outer tyre diameter of front steering axles. The diameter must be

between 0.50 and 2.00 metres.

. Select whether the system is being installed on the left- or right-hand side.

5. Count the number of axles and measure the distance from the front of the
vehicle to the centre of the wheel for each. The number of axles must be between
2 and 7 inclusive. Specify which are steering axles and which are fixed. Rear
steer axles should be marked as steering.

N
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All measurements in
metres and cm

_ Vehicle length from
front to back

-
.—‘

T
1 1
0 1 2 3 4 5 6

of axles

Tyre @ @ :
diameter / Vehicle
7 8 9

width

Distance from front of vehicie (in metres)

Vehicle dimensions for the vehicle details input form.

Input all the details to the vehicle details input form to 2 decimal places (i.e. 2.00 rather than
2 or 2.0). Accuracy of +/- 5 cm is sufficient for all measurements. The diagram will update as
the dimensions are added. The vehicle diagram will flip horizontally depending on whether
a right-hand side or left-hand side installation is selected.

B mm

- Viehidle Di

length: [9.00  m  Cabwidth: [3.00 m
Outer tyre diameter (steering): [ 100 m

¥ LeftSide Installation (" Right Side Installation

‘

No of Axles: |3

;|€

Steering

Fixed

4

IRIREEE
JUJJ L

R S

Installation: sat2

Vehicle file: sat2_v

Vehicle details input form.

IMPORTANT: Make sure the installation side (left or right) is correctly selected before
proceeding. The system will not operate correctly if the installation side is incorrect.
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The vehicle diagram will flip horizontally depending on whether a right-hand side or
left-hand side installation is selected, showing the correct side of the vehicle for this
installation.

When the form has been checked and is complete, save the vehicle configuration to a file
by selecting “Save As” in the file menu. The file extension should be left as .bvc. Previously
saved vehicle configurations can be used by clicking “Open” in the file menu.

When the vehicle data has been saved, the Vehicle Details button will have a green line
below it to indicate it has been completed. The Sensor Details button should become

available. Click on it to move to the next form.

Progress bar with vehicle details complete.

5.2 Sensor Placement and Measurement

The sensors are mounted on the installed side of the vehicle from the front to the back. If
it is not possible to install enough sensors to cover the entire length of the vehicle then it
is important to at least cover the front portion of the vehicle, as this is where collisions are
likely to occur.

IMPORTANT: The configuration software will permit sensors to be fitted with a
horizontal spacing of up to 2 metres, but the horizontal spacing should be kept at a
maximum of 1.7 metres where possible.

IMPORTANT: Sensors should be mounted flush with the side of the vehicle where
possible to minimise the chance of vehicle self-detections.

IMPORTANT: Sensors should not be fitted horizontally adjacent to a steering axle
where the wheel might be detected. Mounting higher than the top of the wheel at a
steering axle will not usually cause a problem.

IMPORTANT: Use the software to confirm sensor positions before doing any physical
installation. Pre-installation survey is strongly recommended to ensure the system
can be fitted.

There are several position rules to follow to ensure the system operates correctly. The
sensors must be positioned according to the following rules:

Sensor Installation Rules

Maximum distance from front of vehicle to first sensor 0.5m
Minimum horizontal spacing between sensors 1.0m
Maximum horizontal spacing between sensors 20m
(1.7 m recommended)
Minimum sensor height 0.6 m
Maximum sensor height 1.4m
Maximum height variation (lowest to highest sensor) 0.4m
Maximum distance between 5 sensors 52m
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5 System Configuration Tutorial

Minimum distance between 5 sensors 5.2m

Minimum distance between sensors 1.0m
Maximum distance between sensors 2.0m

Max height
difference
0.4m

Maximum distance to
first sensor 0.5m

Distance from front of vehicle (in metres) 0.5m

Sensor position rules
5.3 Sensor Details Input Form

Click the Sensor Details button at the far left of the progress bar. This will open the sensor
details input form. First select the number of sensors used in the installation. Sensor dis-
tance (from the front of the vehicle) and height (above the ground) should then be entered
into the sensor details input form. Input all the details to 2 decimal places (i.e. 2.00 rather
than 2 or 2.0). Accuracy of +/- 5 cm is sufficient for all measurements. Once valid sensor
positions have been inputted, the configuration software will indicate the required sleeve
angle and sensor type. A positive sleeve angle (+) indicates the sleeve pointing upwards to
prevent ground detections. “Black” and “White” sensor types can be distinguished by the
colour of the back of the sensor.

e mm

~Sensor

]
%
%

Recommended
Sleeve

£
g
g
g
"
3
F
3
]

LEEEEE!

TTTTITTTTTSE[E 5

Type
+13 deg White
+i8deg  White
+11deg  Black

0deg  Black

+l8deg  White

~
8

+i8deg  White

AT

Files

Installation: DavesAutos

Sensor file: no file

28 Sensor details input form with sensor types and recommended sleeve angles highlighted.

When the sensor positions have been confirmed as valid by the configuration software,
save the sensor configuration. Leave the file extension as .bsc. Previously saved sensor
configurations can be used by clicking “Open” in the file menu.

The Sensor Details button will show a green line below it, indicating completion of that stage.

L - - _ u

Progress bar with vehicle details and sensor details complete.

5.4 Installing the Hardware

At this point the vehicle and sensor details input forms have been completed. The system
will now require some tests to be passed to confirm correct installation. Some of these
tests are mandatory and others can be skipped, however Brigade strongly recommends
running all tests to confirm the system is installed correctly.

To run these tests, the hardware must be installed to the vehicle and the sensors
programmed with their correct numbers. For more details on hardware installation see
Section 6. For specific information about programming the sensor, go to Section 6.8.

5.5 Connecting to the Algorithm ECU

Connect the PC to the USB connector located on the algorithm ECU. A USB extender cable
may be needed to enable comfortable use of the PC. Once the algorithm ECU is connected

to the configuration software it moves into configuration mode, indicated by a flashing green
light on the buzzer. The ECU will remain in configuration mode until the system is restarted.

When the ECU is powered and connected to the PC via the USB connection, the port number
should appear in the “COM Port” drop-down list. If the port number does not appear, click
the “Refresh COM Ports” button. Note that port numbers for other unrelated connected
devices may also appear in the “COM Port” drop-down list. If unsure, disconnect any other
devices before connecting to the ECU and click the “Refresh COM Ports” button again.

e R T | ‘ | — ‘

ECU connection area with algorithm ECU ready to be connected. COM port can be any number.

Select this port number and click “Connect”. When the ECU is powered the buzzer display
should show a flashing green light on the power/fault LED. When connection is successful
and no tests have previously been performed, the following message will appear:

Connected: New ECU >

@ Connected to a new ECU. ECU serial number will be recorded
to file.

Successfully connected to a new algorithm ECU. 29
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When connection is successful and some tests have been previously performed in this
installation, the serial number will be recognised, and the following message will be
displayed instead.

Connected: Same ECU x

™ ECU serial number matches installation file. Loading all

¥ previously performed tests,

Successfully connected to a recognised algorithm ECU.

When connection is successful, the “Connect” and “Refresh COM Port” buttons will be
greyed out and the “Disconnect” button will become available. This shows the system has
connected to the ECU and that it is a new connection. The status box on the right-hand
side of the ECU connection area will display “Connected”.

Refresh COMPorts comPort; 3 -] | Connect | ‘ Disconne ct ‘ Connected

Successfully connected to the algorithm ECU.

If there is a problem connecting, an error message will appear towards the top of the screen
stating “Could not connect. Please reset ECU.”. If the error message appears, close the
program, disconnect the USB cable, power cycle the algorithm ECU and re-connect the
USB cable.

IMPORTANT: Each installation requires a new installation file. It is not possible to reuse
an installation file for multiple installations. The tests confirm that the physical
installation is correct and must be performed again for each installation. Consequently,
each new algorithm ECU requires a new installation file. The algorithm ECU serial
number is recorded in the installation file after connecting.

In addition to the “Connected” message appearing, the Sensor Walkthrough button in the

progress bar will also become available

Progress bar after algorithm ECU connected with vehicle details and sensor details complete.

5.6 Sensor Walkthrough (Mandatory)

Once the sensors have been mounted and connected, this test checks they are in the correct
numerical order. The system needs to have the sensors installed in the correct order to
operate correctly. This test must be performed to configure the system. Click the Sensor
Walkthrough button on the progress bar to start the test.
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Starting from the front of the vehicle, the user should walk up to each sensor and place
their hand over the sensor about 5-10 cm away to block it for one or two seconds. It is not
necessary to touch the sensor. Then move to the next sensor and repeat until you have put
your hand over to the last sensor. An audible indicator will be played through the PC when
each sensor has been triggered.

Return to the configuration software and it will show the order of the sensors. The order
should be numerically correct, e.g. 1, 2, 3, 4, 5, 6 for a 6 sensor installation. If the sensors
are not in the correct order, they can either be swapped or re-programmed using the
hand-held tool.

If the sensors are in the correct order, the test will state that it has passed. The Sensor
Walkthrough button will display a green line below it and the Triggers Test button will
become available on the progress bar.

Progress bar after sensor walkthrough complete.

5.7 Triggers Test (Mandatory)

This tests that the left, right and reverse gear indicators are correctly connected. These
triggers must be correctly connected for the system to operate correctly. This test must be
performed to configure the system. Click the Triggers Test button on the progress bar to
start the test.

When prompted, the user will need to activate the left then right indicators, then put the
vehicle into reverse. It is not necessary to move the vehicle.

If the triggers are connected correctly and activated in the stated order, the test will state
that it has passed. The Triggers Test button will display a green line below it and the Calibrate
System button will become available on the progress bar.

Sensar
Wakthrough

Progress bar after triggers test complete.

5.8 Calibrate System (Mandatory)

This will check that the algorithm ECU is mounted correctly. You must ensure that the
vehicle is stationary and on reasonably level ground before commencing the test. This test
must be performed to configure the system. Click the Calibrate System button on the
progress bar to start the test.

The algorithm ECU will need to be mounted within 10 degrees of upright. It does not matter
which one of the 6 faces of the algorithm ECU is mounted upwards within 10 degrees of
vertical. See Section 6.6 for more information on acceptable mounting orientations.
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When the algorithm ECU is within 10 degrees of vertical, a green arrow will
be displayed in the panel on the left-hand side.

If the algorithm ECU is tilted too much (greater than 10 degrees), a red
arrow will be displayed.

Perform the test once the ECU is fixed in its final position. The test will
continue for a few seconds once the mounting orientation is acceptable.
If the orientation is correct, the test will pass, the Calibrate System button
will have a green line below it and the Sensor Clearance button will
become available.

Progress bar after calibrate system complete.

The “This Way Up” warning sticker should be attached to the ECU once calibration is
complete so that the ECU is not moved at a later date.

5.9 Sensor Clearance (Recommended)

This checks for any obstructions or ground detections for any of the sensors. For example,
a sensor mounted in a low position could be detecting the ground if it is not angled up
high enough.

During the test, the user will be asked to turn the steering wheel to full lock one side and
then to the other side. This is to ensure the sensors mounted near to a wheel that steers do
not detect any part of the wheel while the vehicle is turning.

The system needs a clear, unobstructed gap of 3 metres between the side of the vehicle
and any other objects to pass this test. This should extend 2 metres forward of the front
sensor and 2 metres backwards from the back sensor. It might not be possible to pass this
test if there is not 3 metre clearance at the side of the vehicle. If it is safe to do so, the
vehicle can be moved to a position where there is enough space. The test can be run
parked at this new location.

Click the Sensor Clearance button to start the test. This test will run for approximately 40
seconds and report back if there are any detections found. If the sensors do not detect
anything the test will pass.

The sensor clearance test shows the number of detections on each sensor. If something is
detected the test will fail and indicate which sensor is causing the fault. If the source of the
detection can be determined, remove the obstruction or move the sensor then run the test
again.
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To diagnose the source of a failure diagnostic mode (see Section 7.2.4) can be used to
record the output from the system. Guidance around sensor positioning and mounting (see
Section 6.7) should be followed to prevent vehicle self-detections. Ensuring sensors are
flush to the side of the vehicle and not in-board is the most important for preventing vehicle
self-detections. If there are no obvious obstructions but the test still fails, skip the test and
perform ELM. After ELM has been performed return to the sensor clearance test which
should now give improved results.

The test may also fail with detections due to high frequency background noise, e.g.
pneumatics or jet washing. If so, run the test again at a new location or with the noise
source removed.

IMPORTANT: The test can be skipped, but correct operation then cannot be
guaranteed. We strongly recommend running this test. Skipping the test will be
recorded to the installation log file.

If successful, the Sensor Clearance button will have a green line below it and the ELM
button will become available.

Progress bar after sensor clearance test complete.

If the test is skipped, this will be noted on the progress bar and in the installation log written

to the algorithm ECU. The ELM button will become available.

Progress bar after calibrate system complete.

5.10 ELM (Recommended)

This will activate environmental learning mode (ELM) to ignore any vehicle self-detections.
In some circumstances sensors can detect parts of the side of the installed vehicle and
activating ELM checks for any such detection and configures the individual sensor to

ignore this detection. ELM will ignore vehicle self detections at distances up to 130 cm.

ELM should always be performed irrespective, of whether the sensor clearance test has
passed or failed. Intermittent vehicle self detections may occur only when the vehicle is
moving and ELM will allow the system to ignore such detections.

The system needs a clear, unobstructed gap of 3 metres between the side of the vehicle
and any other objects for the duration of this test. This should extend 2 metres forward of
the front sensor and 2 metres backwards from the back sensor. It will not be possible to
pass this test if there is not 3 metre clearance at the side of the vehicle. If it is safe to do
so, the vehicle can be moved to a position where there is enough space. The test can be
run parked at this new location.
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Click the ELM button to activate the test, which will take about 60 seconds. After the

test is complete any activated ELM positions will be reported, noting the distance of any
ignored object for each sensor. If any positions are activated, please check the area around
the sensor and ensure the detection is not caused by a foreign object (e.g. a toolbox).

The test will fail if:
* Sensors are connected or disconnected during the test.
* The objects around the sensor are moved or changed.

IMPORTANT: The test can be skipped, but correct operation then cannot be
guaranteed. We strongly recommend running this test. Skipping the test will be
recorded to the installation log file.

If successful, the ELM button will have a green line below it and the Turn Test button will
become available.

Sensar Triggers Caibrate Sensar Tum I
- TS S _ Wiakthvough Test System Clearance GL Test Eaid

Progress bar after sensor clearance test complete.

If the test is skipped, this will be noted on the progress bar and in the installation log written
to the algorithm ECU. The ELM button will become available.

Progress bar after calibrate system complete.

5.11 Turn Test (Recommended)

This test will involve driving the vehicle slowly. It can be performed in a very short space of
a few metres. This should not be performed on a public road and the PC should not be
operated by the driver. It needs only a few metres slowly forward, slight turn to the left at
full lock, slight turn to the right at full lock and then to reverse slowly a few metres.

IMPORTANT: Please ensure it is safe to perform the manoeuvres before running the
test. The configuration software will ask the driver to do the following:

1 Drive the lorry forwards a few metres. A beep will sound on the PC. Stop the
vehicle.

2 Turn the steering wheel full lock to the left and drive for ~1 second. A beep will
sound on the PC. Stop the vehicle.

3 Turn the steering wheel full lock to the right and drive for ~1 second. A beep
will sound on the PC. Stop the vehicle.

4 Straighten up and reverse the vehicle a few metres. A beep will sound on the
PC. Stop the vehicle.

The software will inform the user of the progress. It will provide an audible indicator on the
PC after each stage passed, or if a failure occurs at any time.
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IMPORTANT: The test can be skipped, but correct operation then cannot be
guaranteed. We strongly recommend running this test. Skipping the test will be
recorded to the log file.

Once this test is complete, the Turn Test button will have a green line below it and the Export
to ECU button will become available.

Progress bar after turn test complete.

If the test is skipped, this will be noted on the progress bar and in the installation log written
to the algorithm ECU. The Export to ECU button will become available.

Triggers Caibrate Sensar
Test System ‘ Clearance B

Progress bar after turn test skipped.
5.12 Exportto ECU

When the final test is complete, click the Export to ECU button. This is necessary to export
the vehicle configuration, sensor configuration, and test results to the algorithm ECU
before exiting the configuration software to finish the installation. The software will take a
few seconds to send the data. When complete, the configuration software will report that
the files were sent successfully then restart the system. Once complete the Export to ECU

button will have a green line below it.

Progress bar after configuration complete.

£x
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Before disconnecting, save the programmed configuration file, fitting log and error logs
from the COMMS menu for later reference. Once finished, disconnect from the algorithm
ECU using the button in the ECU connection area, close the configuration software and
disconnect the USB cable.

Restart the vehicle’s electrical system with the system disconnected from the PC. The system
will reboot into normal standalone mode. If configuration was completed the alarm will display
a self-test on start-up. The system will now detect moving objects in the detection area.

The Sidescan®Predict driver information sheet should be left in the cab for the driver.

5.13 Confirming Correct Installation
To confirm the system is working with a parked vehicle do one or more of the following:

- Place an object within 1m of the front sensor. When the nearside indicator is activated,
a solid yellow visual alarm will be given.

- Move quickly in from the back of the vehicle towards the front on the installation side,
which will result in a solid yellow visual alarm.

- Move quickly in from the back of the vehicle towards the front on the installation side
within 1 metre of the sensor array, with the nearside indicator active.
This will provide a single audible beep in addition to the solid yellow visual alarm. 35
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6.1 Installation Site

The installation site should have enough space to verify correct operation of the system.
There should be 3 metres of space on the installed side of the vehicle to verify correct
sensor operation. There should be space to safely manoeuvre the vehicle at low speeds to
verify vehicle motion monitoring is operating correctly. The installation should be performed
on a flat surface with less than 5 degree gradient.

6.2 System Diagram

Subsystem Sid ®Predict i
A - Ultrasonic < P Splitter > .
ECU
Buzzer 1 > Sidesc.an@Predict
Display *
. B Splitter @
Sidescan®Predict
Algorithm ECU Reverse
Right
Triggerin €——— Left
Trigger In 4
Speed (B7)
Indicator
Trigger Out ———p :::x ;
Alarm 3
UsSB
12/24v S5A External
Power Fuse Power Supply

Block diagram showing all components of the Sidescan®Predict system.

6.3 System Setup
To set up, the user must configure the system across USB using a PC or laptop.

The configuration software takes details about the dimensions of the vehicle and positions
of sensors.

IMPORTANT: It is recommended that the proposed configuration is run through the
configuration software before any physical installation, to make sure that the proposed
configuration is valid.

36

6.4 Electrical Connections to Vehicle

Electrical connections to the vehicle all come from the algorithm ECU. The algorithm ECU
then powers and communicates with the sensor subsystem and buzzer display. The
connections between the algorithm ECU and vehicle are described here. Connections
between the system components are described in Section 6.5.

REVERSE
RIGHT

LEFT
TRIGGER IN4
SPEED (B7)

GND
12/24VDC

INDICATOR
ALARM 1
ALARM 2
ALARM 3

Block diagram showing all components of the Sidescan®Predict system.

6.4.1 Algorithm ECU Power

The algorithm ECU power tail cables are marked “12/24VDC” and “GND” and should be
connected to the vehicle ignition circuit. All other components are powered from the
algorithm ECU. The system is supplied with a 5A automotive blade fuse.

6.4.2 Input Triggers and Speed Input

There are four input trigger cables on the algorithm ECU and one cable for the speed input.
The left, right and reverse input trigger cables should be connected to the respective vehicle
triggers. The speed input cable should be connected to a tachograph B7 output. The
“trigger in 4” cable is not used in this system and should be safely terminated and robustly
constrained.

No intermediate relays or hardware components are required.

IMPORTANT: The speed input cable must be connected to the B7 output of the vehicle
tachograph. If the speed cable is connected to any other output, the system will not
operate correctly. The location of the tachograph B7 for a typical tachograph is

shown below, but this may vary with tachograph models. 37
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Location of B7 on a typical tachograph. May vary dependent on tachograph model.

IMPORTANT: The system assumes the speed signal is taken from the rear wheels of
the vehicle. Performance at high turn rates may vary on vehicles where speed is taken
from the front wheels.

IMPORTANT: The system assumes the tachograph speed signal input is taken from
a motion sensor. Performance at low speeds may vary where the tachograph speed
signal input is taken from the CAN.

6.4.3 Output Triggers and Integration of External Alarm

There are four switched ground output triggers on the Sidescan®Predict system. These
function as described in the table below:

Trigger | Trigger Activated when:
number:| name:
1 Indicator | Left trigger is active on left hand side installations. Right hand
trigger is active on right hand side installations. Speed must be
below system shutdown speed (30 kph/18.6 mph).

Used to integrate external alarm.

2 Alarm 1 Moving object is detected.

Speed must be below system shutdown speed.
3 Alarm 2 | “Danger of collision” alarm is active.

Speed must be below system shutdown speed
4 Alarm 3 | “Collision predicted” alarm is active.

Speed must be below system shutdown speed.

To integrate an external alarm, connect the positive of the alarm to the vehicle ignition circuit
and the ground of the alarm output trigger 1. When the indicator is activated and the speed
is below the system shutdown speed (30 kph/18.6 mph), the switched ground will activate,
and the alarm will be powered.

Each output trigger can provide a switched ground for up to 750 mA at 32 V.
Any unconnected output trigger should be safely terminated and robustly constrained.
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6.4.4 USB Connector

The algorithm ECU has a USB connector used during configuration and fault diagnosis.
The cable and plug should be protected after configuration so that no debris can enter
and it cannot become damaged during vehicle operation. After installation ensure the USB
cable is robustly constrained to prevent contact with other tail cables or other equipment
during the vehicle’s operation.

6.5 Electrical Connections between Sidescan®Predict Components

This section describes the connection between the main Sidescan®Predict components. It
describes separately connection between the buzzer display and algorithm ECU, connection
between the algorithm ECU and UDS ECU, and connection between the UDS ECU and
the sensors. Different lengths of extension cables can be used between each connection
depending on the requirements of a given installation.

6.5.1 Connecting UDS ECU to Sensors

The UDS ECU is connected to the sensors via a sensor bus configuration. 4-way splitter
cables are used to connect multiple sensors, extension cables, and other splitters to the
bus. 3-pin extension cables can be inserted at any point in the bus as required by the
installation. The maximum cabling length between the UDS ECU and any sensor is 30 metres.
Any unused connectors on the splitters should be closed off using the attached end caps
to maintain ingress protection.

Sensor bus connections between UDS ECU and sensors.
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6.5.2 Connecting Algorithm ECU to UDS ECU

The algorithm ECU is connected to the UDS ECU with an adapter cable (SSP-0.3-AC2) and
optional 4-pin extension cable. The maximum extension length is 30 metres.

Adapter cable and optional 4-pin extension cable between algorithm ECU and UDS ECU.

6.5.3 Connecting Algorithm ECU to Buzzer Display

The algorithm ECU is connected to the buzzer display with an adapter cable (SSP-0.3-AC1)
and optional 3-pin extension cable. The maximum extension length is 15 metres.

Adapter cable and optional 3-pin extension cable between algorithm ECU and buzzer display.

6.6 ECU Mounting

The algorithm ECU should be mounted in the cab and is not suitable for mounting on the
vehicle frame due to its IP rating. The UDS ECU can be mounted in the cab or on the vehicle
frame at the installer’s discretion.
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The algorithm ECU must be mounted with at least one flat side facing down. There are 6 valid
mounting orientations. The diagrams below show valid and invalid algorithm ECU mounting
positions. The validity of an ECU mounting orientation will be confirmed by the configuration
software during the installation process. This should be fixed securely with screws and not
moved after installation.

Valid: Invalid:

<&

DOWNi DOWNL
Y L e Vi a1

Valid and invalid algorithm ECU mounting orientations.

6.7 Sensor Mounting and Location

The sensor positions must be verified with the configuration software. Invalid sensor
positions will cause the system to malfunction. The configuration software will not permit a
user to set up the system unless the input positions are valid.

There are “black” and “white” type sensors, which must be programmed with the correct
IDs and mounted in accordance with the recommendations from the configuration software.

Please ensure the sensor coating is not damaged during installation as this may cause
corrosion issues.

IMPORTANT: The configuration software will permit sensors to be fitted with a
horizontal spacing of up to 2 metres, but the horizontal spacing should be kept at a
maximum of 1.7 metres where possible.

IMPORTANT: Sensors should be mounted flush with the side of the vehicle where
possible to minimise the chance of vehicle self-detections.

IMPORTANT: Sensors should not be fitted horizontally adjacent to a steering axle
where the wheel might be detected. Mounting higher than the top of the wheel at a
steering axle will not usually cause a problem.

IMPORTANT: Use the software to confirm sensor positions before doing any physical
installation. Pre-installation survey is strongly recommended to ensure the system

can be fitted.
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6 Hardware Installation

6.7.1 Sensor Positions

The correct position of the sensors is important to ensure the system operates correctly.
These should be verified using the installation software. The sensor position rules must be
followed:

* To cover the blind spot without any gaps.

» To ensure detection of vulnerable road users.

« To prevent interference between sensors.

« To prevent ground, curb, or vehicle self-detections.

Please adhere to the sensor position rules defined in Section 5.2 and the sensor sleeve
rules defined in Section 5.3 when setting up the system. If the height of parts of the vehicle
body vary during use, the system must be fitted at the normal running height.

Sensors should be mounted flush with the side of the vehicle. Inboard sensors may be
subject to reflections from the vehicle body, resulting in false alarms from vehicle
self-detection. Diagnostic mode (see Section 7.2.4) can be used to check sensors are not
giving false detections.

Some sensors and cables may need to be mounted in positions where they might be
exposed to flying debris. If this is the case sensors should be suitably protected with
bracketry and cables should be protected with conduits.

6.7.2 Sensor Rotations

The sensors are marked with an “UP” marking which shows which way up the sensor
should go.

— S —11

“UP” marking on a sensor.

IMPORTANT: The “UP” marking must be pointing straight up relative to the ground and
not relative to any mounting surface on the vehicle. The Sidescan®Predict sensors have
multiple grooves spaced at 45 degrees to allow flexible sensor mounting. These
cannot be used as guides to determine correct rotation. The installer must check the
“UP” marking on the sensor.

6.7.3 Sensor Sleeves and Underslung Housings

The sensors can be mounted on a horizontal surface using an underslung sensor housing

with a sensor sleeve, or flush to a surface by inserting a sensor sleeve directly. The sleeves
are used to angle the sensor upwards where required. The selection of sleeves should be
performed with the configuration software.
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Flush mounting through a vertical surface is achieved using a sensor and sleeve. A 28 mm
diameter hole will be required to flush mount the sleeve into a surface.

Flush mounting of a sensor/sleeve assembly to a vertical surface.
Mounting to a horizontal surface requires a sensor, a sleeve and an underslung housing.

Underslung mount assembly for mounting a sensor to a horizontal surface.

6.7.4 Mounting to Uneven Surfaces

Mounting to uneven surfaces is not recommended. Deviating from recommended mounting
angles will degrade the performance of the system.

If a sensor sleeve must be mounted to a surface which is not vertical, or an underslung
housing mounted to a surface which is not horizontal, the installer should measure the angle
of the surface using a digital spirit level (e.g. a smartphone app) and adjust the sleeve angle
accordingly. Examples are given below.

Example 1: A sensor sleeve of +11° is recommended, but the vertical surface for flush
mounting is measured 80° off horizontal. In this case the sensor will already be angled
upwards 10° before the sleeve is added. Subtract 10° from the recommended angle to get
the ideal sleeve (+1°).

If available a sensor sleeve of 0° should be used as the result is the closest to the
recommended.
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6 Hardware Installation

Recommended sleeve = +11°.

Recommended minus “surface bias” = +11° - 10° = +1 °.

Closest available = 0°. Use a 0° sleeve. =% )
‘_Mountlng
80 degrees Surface

Flush mounting to an uneven vertical surface.

Example 2: A sensor sleeve of +5° is recommended, but the mounting surface is angled 15°
upwards from horizontal. In this case the sensor will already be angled up 15° before the
sleeve is added. Subtract 15° from the recommended angle to get the ideal sleeve (-10°).

A sensor sleeve of -11° should be used as the result is closest to the recommended.

Recommended sleeve = +5°. .

Recommended minus “surface bias” = +5° = 15° = -10°.

Mounting
Closest available = -11°. Use 11° sleeve angled downwards.

Surface mounting on an uneven horizontal surface.

6.7.5 Vehicle Overhang into Detection Area

Placing sensors near overhanging objects should be avoided. Where there is no alternative,
it is recommended to place sensors above or below overhanging objects rather than to the
side of them, as the vertical detection beam is smaller than the horizontal. Consequently,
objects above or below are less likely to be detected than objects to the side. Check the
detection patterns in Section 1.3 to see whether an object is likely to be detected.
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6.8 Sensor Programming

The sensor programmer has four buttons and a 2-digit seven segment display. It can be
used to read the current ID of a sensor or to program a new ID. It should be connected to
a power source (the sensor bus or an external 12/24V supply can be used) and to a single
sensor as shown below.

Connect to powered sensor bus or
external power supply

<l

<

E Connect sensor to be programmed

Sensor programmer connections.

To read the current ID of a sensor press READ and the ID will be shown on the display. To

program the sensor, select the required sensor ID using the + and — buttons and press the
WRITE button. If the ID is valid the LED will flash green and an audible alarm will sound.

This indicates the sensor is correctly programmed. If the ID is not valid the LED will flash
red. This indicates the sensor ID is unchanged.

6.9 Cabling

Cables should be run in conduit and along suitable cable runs throughout the vehicle.
Avoid running cables with vehicle power cables to prevent possible interference. Ensure
cabling and connectors are fitted away from sources of excess heat, vibration, movement,
and water.

To prevent cable damage always allow a reasonable radius when folding excess cable and
do not over tighten cable ties. Avoid pulling on the connector or tight bends close to the
connector.

6.10 Buzzer Display

The buzzer display should be mounted so the vehicle operator has good visibility in all
environments and situations. It should not obstruct the driver’s view of windows or mirrors.
The display should be fixed in a suitable location in line with any current legislation/
regulations. The mounting location should reflect that the system is for side detection only.

If mounting with an adhesive or adhesive pad, use rubbing alcohol (70% isopropy! alcohol)
to clean the surface. Make sure the surface is dry and cleared of any dirt. If using the
adhesive or adhesive pad on surfaces which contain plasticizer, for example EPDM or
PVC, please check the plasticizer-resistance of the material to ensure that this mounting
method is suitable.
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7 Testing and Maintenance

7.1 Information

This information is addressed to the installer and operator of the vehicle where a Brigade
Sidescan®Predict system is installed:

1) The Brigade Sidescan®Predict is intended as a driver assistance system and should
not be relied upon as your primary defence for the safe operation of the vehicle.
It is an aid to contribute, in conjunction with other established safety programs and
procedures, to ensure safe operation of the vehicle in relation to surrounding
persons and objects.

2) Testing and inspection of the system should be carried out in accordance with this
manual. The driver or operator is responsible for ensuring the Sidescan®Predict
system is working as intended.

3) Operators using this equipment are strongly recommended to check the system’s
proper operation at the beginning of every shift.
4) Improved safety depends on the proper function of this product in conformance

with these instructions. It is necessary to read, understand and follow all instructions
received with the Sidescan®Predict system.

5) The Sidescan®Predict is intended for use on commercial vehicles and machinery
equipment. Correct installation of the system requires a good understanding of
vehicle electrical systems and procedures along with proficiency in installation.

6) Store these instructions in a safe place and refer to them when maintaining and/or
reinstalling the product.

7.2 System Diagnostics

The system diagnostics here describe methods to determine the configuration and any
errors that have occurred. If you do not have access to the installation file for this vehicle, a
new installation can be used to run any diagnostics (select “New Installation” when the
configuration software is opened). The configuration of the system will not be affected unless
“Export to ECU” is clicked.

7.2.1 Configuration File

The ECU configuration file can be obtained by selecting “Get Config” from the “Comms”
drop-down menu. This will save the ECU configuration as a text file and a csv file. Both
contain the same information.

Once downloaded the files can be found in the user’s documents folder:
Documents\Sidescan Predict\ECU Configurations\

This file will provide the current configuration of the algorithm ECU, with content from the
vehicle details input form and the sensor details input form.
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7.2.2 Installation Log

The ECU installation log can be obtained by selecting “Get Installation Log” from the
“Comms” drop-down menu. This will save the fitting log as a text file and a csv file. Both
contain the same information.

Once downloaded the files can be found in the user’s documents folder:
Documents\Sidescan Predict\ECU Installation Logs\

The file will give all the important installation information, such as the time of installation,
the test results, any tests skipped, and the names of the vehicle details and sensor details
files used.

7.2.3 Error Logs

The ECU error log can be obtained by selecting “Get Error Log” from the “Comms”
drop-down menu. This will save the error logs as a text file and a csv file. Both contain the
same information.

Once downloaded the files can be found in the user’s documents folder:
Documents\Sidescan Predict\ECU Error Logs\

This will provide a list of all errors logged, with each error showing the system state at the
time of the log and an error code.

7.2.4 Diagnostic Mode

This is accessible by selecting “Diagnostic Mode” from the “Help” drop-down menu. It will
display the readings from all UDS sensors and other outputs from the system in real time.
It will save all these results into a txt file and a csv file located in:

Documents\Sidescan Predict\Diagnostic Data

IMPORTANT: Under no circumstances attempt to read diagnostic data while operating
the vehicle.

7.2.5 Environmental Learning Mode (ELM)

This is accessible from the “ELM” drop-down menu. The user can run ELM on currently
activated sensors or check the current state of ELM on the sensors.

ELM settings are stored on the sensors, not on the ECU. Changing the sensors will mean
the ELM settings are lost and likewise changing the ECU components will not change the
ELM settings. ELM settings can only be changed by running ELM again.

Activating ELM requires a clear space on the installed side of the vehicle as described in
Section 5.10.
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7 Testing and Maintenance

7.3 Troubleshooting

Errors due to loose connections, damage to components or incorrect installation may cause
the system to shut down or otherwise present an error state. The table below describes
specific errors that can be observed and their causes and fixes.

flashing green light

configuration mode

Observation Cause Fix
Power/fault LED is showing a System is not Configure the system with the
constant red light configured configuration software
Power/fault LED is showing a System is in Disconnect the configuration

software and restart the system.

No light on the buzzer display

Buzzer display is not
powered or broken

Check the connection to the buzzer
display. If the connection is OK, it
may be necessary to replace the
cables or the buzzer display

After restart power/fault LED is
showing an alternating amber
and green light, which continues
indefinitely.

No valid firmware, or
connection between
algorithm ECU and
buzzer display is faulty

Check valid firmware is loaded on
to the algorithm ECU (“Help” ->
“Get ECU Details”). Check
connection between algorithm
ECU and buzzer display

After restart the power/fault LED
shows an alternating amber and
green light for 10 seconds. Then
the buzzer display does a self-test
and the power/fault LED shows a
solid amber light.

No data is being
received from the UDS
ECU

Use diagnostic mode to check
whether any UDS data is being
received. Check connection
between algorithm ECU and UDS
ECU. If this does not work, it
may be necessary to replace the
cables between the two ECUs or
the UDS ECU itself

After restart the buzzer display
does a self-test and the power/
fault LED shows a solid green light
for one second. Then the power/
fault LED shows a solid amber
light, but the buzzer display does
not beep.

Algorithm ECU
orientation does not
match configuration.
Algorithm ECU may
have been moved
after installation

Check the algorithm ECU has not
moved since the installation.

If it has, either return the
algorithm ECU to its original
mounting position or reconfigure
the system

After restart the buzzer display
does a self-test and the power/
fault LED shows a solid green light
for three seconds. Then the
power/fault LED shows a solid
amber light and the buzzer display
beeps one or more times

One or more sensors
are missing,
disconnected, or
broken

At start-up, the system will give one
beep for each sensor that the UDS
ECU cannot see. Use diagnostic
mode to determine which sensors
are missing. Check the connections
to these sensors and replace them
if necessary

System does not turn off at
30km/h, turning off at lower, higher,
or random speeds

Incorrect speed
signal connected

Check the speed signal connection
to the algorithm ECU. Check the
speed signal is connected to the
tachograph B7 output
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7.4 System Performance

If there is no fault displayed but the system gives excessive false positives there are several
possible causes.

+ Vehicle self-detection by one or more sensors. Use diagnostic mode to check
for self-detections. Activate ELM (environmental learning mode). Ensure the sensor
is flush to the side of the vehicle and other sensor positioning and mounting
guidelines have been followed.

+ Sensor positions are incorrect or do not match the configuration on the ECU.
Check with the configuration software

+ Sensor sleeves are not correct for the sensor positions given. Check with the
configuration software.

« Sensor positions are correct and valid but not optimal. See the guidance in
Section 3.3.
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8 Specifications

8.1 System Operation Characteristics

Detection range 25m
Detection pattern See Section 1.3
Detection resolution 2cm

Detection accuracy +/-2 cm
Detection sampling rate 10 Hz
Response time after detection | <100 ms
Start-up time <3 seconds

8.2 System Electrical Specification

Operating voltage

10-32V

Input current
(with 16 sensors)

Typical: 200mA @ 12V /140 mA @ 24V
Maximum: 470 mA @ 12V /380 mA @ 24 V

Fuse 5A Automotive Blade Fuse
Polarity Negative Ground

Trigger input voltage Active High/9V

Speed signal Tachograph B7 0-5V

Trigger output characteristics

Active State: switched to ground up to 750 mA @ 32 V
Inactive State: High impedance (> 1 MOhm)

8.3 Maximum Connection Lengths

Cable between UDS ECU 30m
and any sensor

Cable between algorithm 30m
ECU and UDS ECU

Cable between algorithm 15m

ECU and buzzer display

8.4 Buzzer Display Specification

Weight

72 9

Mounting

In cab with adhesive pad or AMPS mount, see Section 9.5

IP protection

IP30

Operating temperature

-30 to +80 °C

Volume

Adjustable 5 levels

Sound levels

200Hz 64.3 to 83.5 dB +5 @ 10cm (adjustable 5 levels)
800Hz 68.0 to 82.7dB +5 @ 10cm (adjustable 5 levels)
2450Hz 68.5 to 89.0dB +5 @ 10cm (adjustable 5 levels)

Colours (visual warning)

Yellow, Red

Colours (power/fault LED)

Green, Amber, Red
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8.5 Algorithm ECU Specification

Weight

412g

Mounting

Specified orientation in cab, M5 screws, see Sections 6.6
and 9.4

IP protection

IP30

Operating temperature

-30 to +80 °C

8.6 Sensor Subsystem Specification

Weight (ECU) 1589

Mounting (ECU) Cab or body, M5 screws, see Section 9.3
IP protection (ECU) IP69K

Weight (Sensor) 309

Mounting (Sensor)

Body, through hole mount or M5 screws, See Sections
9.1 and 9.2

IP protection (Sensor)

IP69K

Operating temperature

-30to +70 °C

8.7 Configuration Software Specification

Operating system Windows 10
Minimum resolution 1280 x 960
Recommended screen 100%

magnification

8.8 Sensor Programmer

Specification

Weight 106g

IP protection IP40
Operating temperature -40 to +85 °C
Operating voltage 10-32V
Power consumption <3W

8.9 Approvals

CE

ISO 16750

FCC

IC

ECE Regulation No. 10
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9 Mounting Dimensions

9.1 Sensors, Sleeves and Underslung Housings 9.3 UDSECU
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9 Mounting Dimensions 10 Disclaimer

Ultrasound obstacle detection systems are an invaluable driver aid but do not exempt the
driver from taking every normal precaution, when conducting a manoeuvre. No liability,
arising out of the use or failure of the product, can in any way be attached to Brigade or to
the distributor.

9.5 Buzzer Display
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